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Introduction
What is a Help file
A help file is a document file for the application "WINHELP.EXE" which is a part of Microsoft 
Windows. Help documents are organized into separate TOPICS, a topic is a single page in a help 
file. Within a Topic You can have TEXT, and/or Graphics. You can specify certain text and/or graphics
to be HOT SPOTS, a HOT SPOT is linked to another topic, when the end user clicks on a hot spot 
area, the help document will jump to the specified topic. This type of document management is called
HYPER TEXT.

What is Visual Help
Visual Help is a development environment for Microsoft Windows HELP documents. You can develop
.hlp documents using Visual Help and the Help Compiler only, you do not need any word processing 
application to accomplish this task.

How Visual Help Works
You can develop the topics for the help file by dragging and dropping objects on a topic Window. 
These objects are Titles, Headings. Sub Headings, Paragraphs, Jump labels, and Images. After you 
define your topics you can specify the topic names to jump to for the jump labels and images. You 
also can attach notes to topics for future reference. An outline view of all topics is available to view 
the structure of the help file and it is also used to access the topics for editing.



Not only for Programmers
Visual Help can be used by any one to develop Windows Help Files, You do not need to be a 
programmer. Here are some Ideas you can use Help files for other than applications help.

Company Procedures Manual
Company Databases
Multimedia Authoring
Information Guides
Readme Files
Shared Network Information
Electronic Books

All the above can be shared on a network for all users to access and it is also portable,    you need 
only one file an you can play it on any Windows based computer without the need for an application 
to run it, and with Visual Help ease of use and fast update these tasks will become a breeze.



System Requirements
Hardware Requirements
n Personal Computer using an 80286 or higher microprocessor (80386 is recommended)
n 2 MB RAM (4 MB recomended)
n EGA, VGA, super VGA, XGA, 8514/A or compatible video graphics card.
n Mouse.

Software Requirements
n MS DOS operating system version 3.1 or later.
n Microsoft Windows version 3.1 or later.
n Microsoft Windows Help Compiler version 3.1 or higher.



Getting Started
Quick Introduction
Microsoft Windows help documents are executed using an application called winhelp.exe, it is the 
core engine of Windows help system, Windows help documents names end with the extention .hlp, 
building a Windows help document is a three step process, step one is to build a help project file, 
step two is to build the topics in the help system and all related files such as bitmaps, step three is to 
compile the help project and help topic files to produce a help document, to compile a help project 
you need to have the Microsoft Windows help compiler. Visual help will take care of creating the help
project and the all related files and even executing the help compiler to produce the help document. 
Before jumping into building a Help document let us start buy understanding how a help system is 
structured. First every help document has a starting point, a topic that is displayed when the help 
document is executed, this topic is called the contents topic just like a table of contents in a book. 
From this contents topic you define jumps to other topics in the help document.

Planning
To plan your Help topics is the first step in authoring an effective Help system, so plan well and do 
take the time to organize an outline before starting to build your project. If you are creating Help for a 
Microsoft Windows-based application, you may want to follow these guidelines.

Planning Contents Screens
The purpose of the main contents screen is to provide an overview of the contents of the Help 
system and to give clear, logical paths to information. It should work like the table of contents in a 
book.

Sub-Level Contents Screens
Sub-Level Contents screens open paths from the main contents to individual topics. Category entries
on the main contents screen jump to sub-level contents screens that either list help topics in that 
category or display other sub-level contents screens.

Guidelines for Contents Screens
n Entries can be listed under several different category headings. For example, reference entries 

and procedural entries can be separated.
n Entries are presented by category, as either text jumps or graphic images. List entries in logical 

order (for example, by learning-path, by frequency of use, or alphabetically).
n Your list should include no more than 10 entries. Avoid having more than 15 entries,    if possible. 

If your list is longer than 15 entries, try to break it up with headings or into more than one 
contents screen.

n Avoid deeply nested sub-levels so the user doesn't have to jump more than two or three times to 
display a help topic.

n On contents screens with entries that jump to individual Help topics, avoid long scrolling lists of 
entries.

Planning Topics
Optimally, a Help topic is one, and at most two screens long. A Help screen is defined as 
approximately one half the width of a maximized window and 1520 lines long. Avoid using too many 
pop-up hot spots on a single screen because they can make the screen hard to read.

Creating the Contents Topic
The first topic you create in Visual Help is assigned to be the contents topic. If you decide to change 
the contents topic at a later time in the development select the project options from the options 
menu, under the [OPTIONS] category, select contents from the list then select the topic name to 
assign to be the contents topic from the combo box. Note that the contents topic is an important part 
of the help file, if you have the wrong topic selected as the contents topic, your help document will 
not include all topics you created in the help structure.



Graphics
Visual Help accepts Windows BMP images, if you have a non BMP format image you need to 
convert it to BMP file. Visual Help includes a utility called Image Design to convert Icons "ICO" and 
Windows Meta Files "WMF" and fonts to bitmaps "BMP".
To optimize the size and speed of your help file, convert all 256 color bitmap files to 16 color.

Sound
Visual Help accepts Windows WAV sounds, if you have a non WAV format sound you need to 
convert it to a WAV file. Visual help allows you run Sound recorder from the Window menu. Note all 
sound files must exist in the same directory of the project to be able to assign them.



Procedures
Making a Help file
First Steps
Putting it together
Final Steps

Other supported features
Options
Reports
Export
Import



First Steps
Creating a new Topic
Saving a Topic
Adding Objects
Deleting Objects
Editing Text Objects
Printing Topics



Creating a New Topic
What is a Topic
A topic is a single page in the Help document.

Creating a Topic
n From the File Menu, select New Topic.
or
n From Visual Help Button Bar, click on the first button "T".
n Enter a Topic name in the text box at the upper left corner of the topic window then hit "TAB" Key.
Note when a new topic is created a Title Object is inserted at the top of the Topic, when you edit the 
Topic name, the title will automatically copy the same name. You can delete the title if you do not 
wish it be there.



Saving a Topic
Automatic saving
Topics are loaded in memory when created but are saved automatically in certain situations such as 
when the user hits the runtime button to simulate the help file.

Manual saving
n Click the first Button in the Topic Window Button Bar, (The Disk Icon).
or
n Close the Topic Window from the Control Menu Box.



Adding Objects
Objects
Valid Objects are Titles, Headings, Subheadings, Paragraphs, Bullets, Jump labels, and Images.

Adding an Object at the end of the Topic
n Make Sure the Topic Window you want to add an object to is visible, then drag the Object Icon 

from the Tool Box and drop on the Topic Window when the Icon looks like a paper dropping.

Inserting an Object in the Topic
n Make Sure the Topic Window you want to add an object to is visible, then drag the Object Icon 

from the Tool Box and drop on the object you want to insert before, an arrow Icon will show that 
you can insert.



Deleting Objects
Objects
Valid Objects are Titles, Headings, Subheadings, Paragraphs, Bullets, Jump labels, and Images.

Delete an Object
n Click on the object you wish to delete.
n Click on the trash button in the topic window button bar. "Button #7"



Editing Text Objects
Multiline Text Objects
Paragraph and Bullet objects are multiline Text objects. Pressing the Enter key will expand the object
by one line.

Single Line Text Objects
Title, Heading, SubHeading, and Jump Label Objects are Single line Text Objects, all text must be 
entered on one line.

Tabs
Tabs are allowed in Text Objects, You can enter tabs in the Text by hitting "CTRL-TAB" combination 
keys, if you hit the "TAB" Key by it self the focus will go to the next Text Object in the Topic.



Printing Topics
How to print a single Topic
n Open the Topic you want to print and make it the current topic, the current topic name will be in 

the drop down list of Visual Help main window.
n From the file menu select print. A print options window will popup.
n Select the Current Topic Option
n Click on OK or hit Enter key to print.

How to print multiple Topics
n Open all the Topics you want to print by selecting the topics from the main window drop down list

or from the view window.
n From the file menu select print. A print options window will popup.
n Make sure that "All loaded Topics" Option is selected
n Click on OK or hit Enter key to print.



Putting it together
Add Buttons
Design Images
Define Jumps
Define Winhelp Macros
Define Windows attributes
Define Glossary term
Adding Glossary Object
Playing sound files
Define Non-scroll area
Define Keywords
Adding Index Object
Define Context Id
Attach Note



Add Buttons
What are buttons
You can add buttons to the default Winhelp buttons on the top of the help window, and assign 
Winhelp macros to these buttons.

How to Edit buttons
n From the "Window" Menu select Button Design, a button design window will popup.
n If no button exist you can start typing a button Caption, other wise select insert.
n Enter Button Name Select Winhelp macro to execute when button is selected.
n Repeat for all new buttons.
n Click on OK to save and exit or Cancel to disregard changes.



Design Images
What is the Image design tool
Image design is a tool to help you create logo and button bitmaps to use in you help file.

How to create an Image
n From the Window menu select Image Design.
or
n From the Visual Help Window click on the Camera Icon Button.
n Enter a path and filename for an Icon, Bitmap, or Windows meta file in the image text box, or 

leave blank.
n Type in text in the text box, then select the attributes for the text from the window.
n Click on save to save the image, you will be prompted for a filename to save the bitmap under.
Now you can use this bitmap in your help file.



Define Jumps
n Select a Jump Label or Image Object you want to define Jump for.
n Click on the Action Button in the Topic Window (The second Button). This will open the Action 

Window.
n Select the "Jump to Topic" from the Combo Selection Box.
n Select the Topic Name to Jump to from the List.
n Check the Popup Box if you want the jump to be a popup Jump, other wise leave unchecked.
n Select a window name you want the topic to appear in or leave unchanged if it is the main 

window.
n Click on the OK button or hit Enter Key.



Define WinHelp Macros
n Select a Jump Label or Image Object you want to assign Winhelp Macro for.
n Click on the Action Button in the Topic Window (The second Button). This will open the Action 

Window.
n Select the "Winhelp Macro" from the Combo Selection Box.
n Select the Macro You want executed from the list.
n Click on the OK button or hit Enter Key.



Define Windows attributes
n Select Window Design from the Windows menu.
n A Window design window will come up.
n Select the window name you want to change.
n Enter a Window Caption for the selected Window
n Select if you want the window to be always on top.
n Select a size attribute for the Window, by resizing the windows it self.
n Click on OK to save or Cancel to disregard changes and exit.



Define Glossary term
What is a Glossary term
A glossary term is a definition of a Word or phrase, these definition will appear as popup hot spots in 
a paragraphs when the user compiles the help file... also these definitions will appear alphabeticaly 
in a Glossary object that the user adds in a topic.

How to define a Glossary Term
n Select Glossary from the Windows menu
or
n Highlight a word in a multiline text object and select the action button in the topic window.
n The Glossary definition Window will popup.
n Edit the Glossary Term
n Select the scope of the definition, Global will apply to all topics..
n Select if the term is case sensitive when defining terms.
n Enter the definition of the term
n Select Ok or Cancel to save or disregard changes and exit.



Adding Glossary Object
Why add a Glossary Object
Other than just defining terms in paragraphs as popups, you can drag and drop a Glossary Object 
from the tool bar into any topic, this object will be compiled just like a Glossary at the end of a book, 
listing all terms in alpha order.

How to add a Glossary Object
n Select the Glossary Object in the tool box, drag and drop like any object in a topic.
n A Glossary Button will show in the topic, you wil see the glossary definitions only when you 

compile the project.



Playing Sound Files
n Select a Jump Label or Image Object you want to assign file for.
n Click on the Action Button in the Topic Window (The second Button). This will open the Action 

Window.
n Select "Play Media" from the Combo Selection Box.
n Select the Sound file you want to play on selection from the list. (All sound files must be in the 

same directory as the help file).
n Click on the OK button or hit Enter Key.



Define Non-Scroll Area
What is a Non-scroll area
Non-scroll areas in help files always sticks to the top of the window, and will not scroll with the rest of 
the help contents if the scroll bars where used.

Setting Non-scroll areas
n Click on the last object to be included in the non-scroll area.
n Click on the Non-scroll toggle button in the Topic Window Button bar.(Button #4)
Clicking the Non-scroll button will reverse the previous action



Define Keywords
What is a    keyword
Keywords are used by the end user to search for topics in the help file. Visual help automatically 
assigns all topic names as a keyword for the topic, you can disable this feature if you wish from the 
Options-Environment menu.

Editing Keywords
n Activate the Topic window for the topic you wish define keywords for.
n Click on the key Button in the Topic window button bar, a keyword list window will popup.
n If the selected keyword is empty in the list you can start typing a keyword, other wise click on the 

insert button then type the new keyword.
n Repeat previous process for all keywords.
n Click on the OK button to save all changes, or cancel to disregard.



Adding Index Object
Why add an Index Object
Other than just defining Keywords, you can drag and drop an Index Object from the tool bar into any 
topic, this object will be compiled just like an Index at the end of a book, listing all keywords as jump 
labels in alpha order.

How to add an Index Object
n Select the Index Object in the tool box, drag and drop like any object in a topic.
n An Index Button will show in the topic, you will see the Index jump labels only when you compile 

the project.



Define Context Id
What is Context Id
A topic context ID is used to link a topic to a context sensitive help in an application. Visual help will 
generate all context Ids for you if you wish, You need to make sure that the "regenerate context ids" 
option is set in the environment options, please note that this option will reset to false after the first 
build so you need to set it again to generate context ids automatically, (this is a precaution not to 
overwrite programmer defined context ids which can be set from the topic window or from the outline 
window).

From Outline or Browse Window
n Click on the Context ID button, a context id edit window will popup.
n Enter new context Id then hit OK button.

From Topic Window
n Click on the context id button in the topic window button bar "Button #6", a context id edit window

will popup.
n Enter new context Id then hit OK button.
Note that if you enter a duplicate context id and hit ok, a beep will sound and you are allowed to re-
edit the context id.



Attach Note
Why notes
You can attach notes to topics to help remind you of changes and updates that need to be done, and 
also it is useful if more than one person works on project you can leave notes to co workers to proof 
read, or check something for you.

Attaching a note
n Activate the topic window you want to attach a note for, by clicking on its caption bar for example.
n Click on the pin button in the topic window button bar, "Button # 8". a note edit window will 

appear and the time and date will be automatically stamped in the text.
n Edit the note then click on OK to save or Cancel to disregard.
Notes will not be included in the help file.



Final Steps
Testing the Help file
Making the Help file



Testing the Help file
Runtime testing
n Click on the play button on the visual help button bar, a window will popup emulating the help 

document
n Click on the Stop Button when done.

Outline view test
n Click on the Outline View button on the visual help window button bar "Button # 5"
or
n Select Outline from the view menu.



Making the Help file
Build
n From the Compile Menu, select Build.
Build will create all files necessary for the help compiler to compile the help file.

Compile
n From the Compile Menu, select Compile.
Compile will execute the help compiler to generate the help document.

Run
n From the Compile Menu, select Run.
Run will execute Winhelp with the generated help document.

All the above
n From the Compile Menu, select all the above.
Build, Compile and Run the final help document. 

Note if you are using pif file for the help compiler, make sure that the window will close on exit.



Options
Project Options
Define Styles
Environment Options



Project Options
Why mess with these
If you want to optimize or edit a certain option from the help project file, this is where you need to do 
it. Do not use a text editor because the hpj file will be overwritten after every build. If you do not know
what you are doing do not mess these options.

Editing project options
n From the options menu select Project Options. A project edit window will popup.
n From the combo box select the Project Options Category to edit. The [Options] category is the 

most common area to edit.
n From the list select the option to edit, a text box or combo box will appear on top of the list 

indicating current value.
n Edit the selection value.
n Click Ok Button to save or Cancel to disregard and exit.

Startup Topic "Contents"
The first Topic to save is the topic to be assigned as the startup topic in the help file. You can change 
this to any other topic from the options section of the Project Options, the selection name is 
Contents. When selected a combo box with all topics will appear and you may change and save you 
selection then.



Define Styles
What are styles
A style is the look attributes of an object such as a title or paragraph, in the help document.

Editing styles
n From the Options Menu select Styles, a style definition window will popup.
n From the styles list select the style you want to edit.
n Check, click, and select the attributes for the current style, a visual representation of the object 

will show in the preview box.
n Click OK to save and exit or cancel to disregard.



Environment Options
What are the Environment Options
Environment Options are the options global to all projects.

Help Compiler
The name and path of the help compiler, if the help compiler exists in the dos path then just the 
name.

Regenerate Context Ids
If checked, Visual Help will regenerate all context ids in the .HH file. This Option will reset to false 
after the first Build, that is to ensure that user defined Context Ids are not over written on next Build.

Add topic name to Keywords list
If Checked, Visual Help will add the Topic name to the keyword list automatically. (Default is true)

How to edit the Environment Options
n From the Options menu select Environment, a Window will popup to edit options.
n Edit options.
n Click on Ok Button to save or Cancel to disregard.



Reports
Topics List
Topics Outline
Project Options



Topics List Report
What is on the report
This report will generate a list of all topics in the project with Context Ids.

How to generate report
n From the Report Menu select Topics List option. A report window will show.
n From the report window Click on Print to print the report



Topics Outline Report
What is on the report
This report will generate an outline of the topics with the browse sequence numbers.

How to generate report
n From the Report Menu select Topics Outline option. A report window will show.
n From the report window Click on Print to print the report



Project Options Report
What is on the report
This report will print all current Project Options in the HPJ file.

How to generate report
n From the Report Menu select Project Options. A report window will show.
n From the report window Click on Print to print the report



Export
Export to Manual
Export include files



Export to Manual
How are manuals generated
The manual generated will be a Rich Text Format file with style definitions as follows:

Title = Heading 1
Heading = Heading 2
Sub-heading = Heading 3
Paragraph = Normal

The outline of the Manual will be the same as the outline view.

How to generate Manual
n From the file Menu select Export, the export Wizard will popup.
n Select Manual option then click on Continue.
n Select Rich Text Format or Text file then click on Continue.
n Enter file name and path to export to, if path is not included the current directory will be the 

default.
n Click on Continue to generate the Manual.



Export include files
What is an include file
It is a file a programmer can include with his project to reference Help topics in the help file. It has all 
constants definitions for Context Strings.

Note Visual Help automaticaly generates a .hh file for context ids definitions. This file should not be 
edited manualy because it only includes the generated topics Ids. To generate an include file with all 
topics ids even the ones not built in the help file, you need to export an include file.

How to generate an include file.
n From the file Menu select Export, the export Wizard will popup.
n Select Include file option then click on Continue.
n Select programming language to support then click on Continue.
n Enter file name and path to export to, if path is not included the current directory will be the 

default.
n Click on Continue to generate the Include file.



Import procedures
Import VH projects



Import
Why import
Use Import to get Topics from previously created projects using Visual Help. This feature allows you 
to reuse generic topics.

How to import
n From File menu select Import.
n Locate a Visual Help project File .vh and click OK.
n Import Wizard window will popup with all topics available in the list box on the left.
n Select all Topics you want to import into the current project.
n Click Import to continue.
n If Duplicate topic names are encountered, Visual Help prompt you to rename the topic.



Menu Commands
File Menu
Edit Menu
View Menu
Compile Menu
Options Menu
Reports Menu
Window Menu
Help Menu



File Menu
New
Open
Save
Save As
New Topic
Remove Topic
Import
Export
Print
Exit



New
Create a new project file, and save existing project file if necessary.



Open
Open an existing project file. and save current file if necessary.



Save
Save Current project file.



Save As
Save Current Project under a different name.



New Topic
Create a new topic for the help document.



Remove Topic
Delete current topic from help document.



Import
Open the Import Wizard. To import Topics from other Visual help projects.



Export
Open the Export Wizard. To create Rich Text Format Manuals and Include files to support C, Pascal 
or Basic.



Print
Open Print Dialog box to print topics from the document.



Exit
Quit Application and save current changes if necessary.



Edit Menu
Cut
Copy
Paste
Delete
Find
Find Next
Find Previous



Cut
Remove selection and place on the clipboard.



Copy
Copy selection and place on the clipboard.



Paste
Paste selection from the clipboard.



Delete
Remove selection and do not place on the clipboard.



Find
Open Find Topic dialog box to find a topic name or text within.



Find Next
Find Next occurrence of text specified in the find dialog box.



Find Previous
Find previous occurrence of text specified in the find dialog box.



View Menu
Outline
Browse



Outline
Open outline view Window.



Browse
Open Browse view Window.



Compile Menu
Build
Compile
Run
All the above



Build
Build the help document .rtf and .hpj files, these are files necessary for the help compiler to generate 
the Help .hlp file.
n Bullet gjflk;' jgfl' jkfl 'jkg;' kjl;' gkjlfd' gkjfl hgjs; hgjs; hgjs;ghjs; ghjd; hgj;ghjj hgjfk hgjkd 

hgjdkhgjkldshjkl;



Compile
Compile the .hpj and .rtf files using the help compiler to generate the .hlp file.



Run
Run the generated .hlp file, this will execute the file Winhelp.exe using the generated .hlp document.



All the above
Build, Compile, and run the help file.



Options Menu
Project
Styles
Environment



Project
Opens a dialog box for changing the .hpj (Help Project File) options.



Styles
Opens a dialog box for changing the styles attributes, such as font names, sizes, colors, etc.



Environment
Opens a dialog box for setting the environment options, such as the help compiler file name and 
location.



Reports Menu
Topics List
Topics Outline
Project Options



Topics List
Prepare a report of all topics listed in alphabetical order.



Topics Outline
Prepare a report of topics listed in an outline form according to hierarchy in the help file.



Project Options Report
Prepare a report of all project options, .hpj file contains most of the options listed in this report.



Window Menu
Glossary
Window Design
Image Design
Button Design
Tool Box



Glossary
B
Buttons

C
Compile
Context Id
Context Sensitive

G
GO SWREG

H
Help documents
Hot Spots

K
Keywords

M
MS DOS

N
Non-scroll

O
Outline View

S
SDK
Shed
SHG
Sound files

V
Visual Help

W
WINHELP.EXE
WinWare



Window Design
Open Window Design window.



Image Design
Open Image Design Window.



Button Design
Open Button Design Window.



Tool Box
Open Tool box Window.



Help Menu
Contents
Search
Product Support
Introducing Visual Help
Register
About Visual Help



Contents
Goto the contents of this help file.



Search
Open Winhelp search dialog box for this help file.



Product Support
Get product support channels information.



Introducing Visual Help
Goto introduction Topic in this help document.



Register
Goto Registration topic of Visual Help.



About
Open about Visual Help dialog box.



Tool Bars
Main Window Tool Bar
Topic Window Tool Bar
Objects Tool Box



Main Window Tool Bar
Click on the diffetent buttons of this tool bar for more information.



Topic Window Tool Bar
Click on the diffetent buttons of this tool bar for more information.



Objects Tool Box
Click on the diffetent buttons of this tool box for more information.



Tips and Tricks
Follow these tips for a more productive help development.
n When adding a Topic Window, Click on the new topic button then go directly to the Topic name in

the Topic window and type a new topic name, the title entry will automatically copy the same 
name.

n To create a topic for a jump label, hold down the Control key while clicking on the jump label with 
the left mouse button.

n To go to a topic that is assigned to a jump label, hold down the Control key while clicking on the 
jump label with the left mouse button.

n Use the runtime testing instead of compiling the project to test jumps and sound files.
n Give your Topics logical names that can be used as a keyword for the end user to find the Topic, 

Visual Help will include all Topic names as keywords by default.
n Use the find Topic from the edit window to locate topics in large help files.
n Try not to open many Topic Windows at one time, (even though there is no limit on open topic 

windows, they are limited by your system resources).
n Create Buttons for your help file, for example if you have a form you want the end user to print, 

create a print button for it.
n Give Topic names the same name as in the jump label, this way it is easier to find when tracing 

large help files.
n Save 256 color or higher bitmaps into 16 color bitmaps, this will make the execution of Winhelp 

faster.
n Link images at the end of your development cycle, reason is, the help compiler executes faster 

when no images are included, this will accelerate the debugging process.
n Deselect the Generate Index Objects and Generate Glossary Objects in the build dialog box to 

speed help generation while developing your project.



Questions and Answers
Q
What do I need to generate a Windows help file?

A
You need the Microsoft Windows Help Compiler, available with most of windows development tools, 
such as Visual Basic for Windows pro, Microsoft SDK, and many other, the file name is HC31.EXE or
HCP.EXE.

Q
How Can I import Help projects I have created with Word for Windows?

A
Visual Help is an object oriented text construction tool, You will need to cut and paste the different 
text objects into Visual Help.

Q
Is there any royalties involved in distributing help files I create using Visual Help?

A
No.

Q
How can I define hotspot popup definitions in a multiline object such as a paragraph?

A
Use the Glossary to define the term or phrase, Visual Help will insert the popups for you automaticaly
anywhere in the project.



Registration
Registration by Mail
Registration through Compuserve
Registration by phone "Credit Card Orders"



Registration Visual Help V2.0e
To get a hard copy of the following form select file menu, Print.

To register By Mail (CHECK OR MONEY ORDER ONLY)
Please register my copy of Visual Help, I am sending a check or money order for the amount of 
$49.00.

Sign:________________________________________________________

Name:_______________________________________________________
Company:____________________________________________________
Address1:____________________________________________________
Address2:____________________________________________________
City:________________________________________________________
State:_______________________________________________________
Zip:_________________________________________________________
Country:_____________________________________________________
Tel:___________________________________________________optional

Where did you here about Visual Help
____________________________________________________________

Multi-User Registration
Single user .....................................................$49.00
10 to 20 users ...................................................$400.00
21 to unlimited ...................................................$700.00

Amount inclosed ..............................................................
Please specify disk size: 3.5 inch 5.25 inch

Send completed form with payment to
WinWare
P.O. Box 2923
Mission Viejo CA 92690



Compuserve Registration
To register using Compuserve
To register through Compuserve, GO SWREG and select registration Id# "891", registration fee will 
be billed to your Compuserve account.



Telephone Registration
To register By Phone (CREDIT CARD ORDERS ONLY)
You can order with MC, Visa, Amex, or Discover from Public (software) Library by calling
n 800-2424-PsL
or
n 713-524-6394
or by FAX to
n 713-524-6398
or by CIS Email to 71355,470. 
You can also mail credit card orders to:-

PsL 
P.O.Box 35705 
Houston, TX 77235-5705. 

Make sure to specify "Visual Help"    order #10851, $49.00 will be billed to your credit card. 

THE ABOVE NUMBERS ARE FOR ORDERS ONLY. Any questions about the status of the shipment 
of the order, registration options, product details, technical support, volume discounts, dealer pricing, 
site licenses, etc, must be directed to WinWare at the address bellow or CIS Email 70272,1656.

Questions, Support, and site licenses contact
WinWare
P.O. Box 2923
Mission Viejo CA 92690

or

CIS Email 70272,1656.



Product Support
Product Support for Visual Help is available through the following channels:-

Compuserve
Please direct questions to:

Firas Bushnaq
70272,1656

WinSIG BBS
714-363-9802      2400/9600-N-8-1
Direct Questions to Firas Bushnaq.



What do you get
Latest Version of Visual Help
n More Sample help projects on disk.
n More extensive printing and reporting capabilities.
n More extensive programmer support.
n Import and Export capabilities.
n Help to Manual features to convert your help files into printed Manuals.

Product Support
n Through Compuserve. (CIS ID # 70272,1656)
n Through 24 hour BBS support. (WinSIG BBS 714-363-9802)

New releases
n Notification of new releases.
n Minimal charges for upgrades.



Title
Single line text object.



Enumerated Bullet
Enumerated multiple line text object



Jump Label
Single line jump text object.



Bitmap Jump Label
Bitmap and a single line jump text object.



Bitmap
Bitmap object.



Segmented Hyper Graphic
Bitmap object.



Index
Multiple line text object.



Glossary
Multiple line text object.



Heading
Single line text object.



Sub-heading
Single line text object.



Footnote
Single line text object.



Paragraph
Multiple line text object.



Mono-spaced Paragraph
Multiple line text object.



Bitmap Paragraph
Bitmap and multiple line text object.



Line
Drawing, seperates objects.



Bullet
Bulleted multiple line text object



Glossary
Open Glossary Definition Window.



Index
A
About
Add Buttons
Adding Glossary Object
Adding Index Object
Adding Objects
All the above
Attach Note

B
Basic
Bitmap Design
box1
box10
box11
box12
box13
box14
box15
box16
box2
box3
box4
box5
box6
box7
box8
box9
Browse
Build All
Building Help files
Button Design
Buttons Add

C
C
Compile
Compile Menu
Compile
Compuserve Registration
Contents Help
Contents
Context IDs



copy
Creating a New Topic
Cut

D
Define Context Id
Define Glossary term
Define Jumps
Define Keywords
Define Non Scroll Area
Define Styles
Define Windows attributes
Define WinHelp Macros
Delete
Deleting Objects
Design Images

E
Edit Menu
Editing Text Objects
Environment Options
Environment
Exit
Export include files
Export procedures
Export to Manual
Export
Export

F
File Menu
Final Steps
Find Next
Find Previous
Find
First Steps

G
Getting Started
Glossary Define
Glossary Entries
Glossary terms
Glossary

H
HC31
Help Menu



How to..

I
Images Design
Import procedures
Import Wizard
Import
Import
Include
Index
Introducing VH
Introduction

J
Jumps Define

K
Keywords Define

L
Licence Agreement

M
Macros Define
Macros WinHelp
Mail Registeration
Main Window Tool Bar
main1
Main10
Main11
Main2
Main3
Main4
Main5
Main6
Main7
Main8
Main9
Making the Help file
Manual
Menu Commands

N
New Topic
New Window
New
Non-scroll area
Not only for Programmers



Notes

O
Objects Tool Box
Open
Options Menu
Options
Options
Outline

P
Pascal
Paste
Planning
Playing Sound Files
Print Setup
Print
Printing Topics
Procedures
Product Support help
Product Support
Project Options Report
Project Options Reports
Project Options
Project
Putting it together

Q
Questions and Answers

R
Register
Registeration
Remove Topic
Remove Window
Reports Menu
Reports
Reports
Run
Runtime

S
Save As
Save
Saving a Topic
Search
Secondary Windows



Sound Playing
Styles
System Requirements

T
Telephone Registration
Testing the Help file
Testing
Tips and Tricks
Tool Bars
Tool Box
Top1
Top10
top11
top12
top13
top14
top15
top2
top3
top4
Top5
top6
Top7
top8
top9
Topic Add
Topic Create
Topic Delete
Topic Edit
Topic Print
Topic Save
Topic Window Tool Bar
Topics List Report
Topics List
Topics Outline Report
Topics Outline

V
View Menu

W
What do you get
Window Design
Window Menu



Windows Define attributes
Windows Secondary
Windows



Licence Agreement



Topic
Topic Combo Box, use it to select the topic you want to view or edit.



Runtime End
Click on this Button to end the runtime testing of your Visual Help project.



Help
Click on this Button to open Visual Help's Help.



New Topic
Click on this button to create a new topic.



Open File
Click on this button to open an existing Visual Help project.



Save Project
Click on this button to save your Visual Help Project.



Outline View
Click on this button to open the outline view of your Visual Help project.



Window Design
Click on this button to start the Window design tool.



Image Design
Click on this button to start the Image design tool.



Button Design
Click on this Button to start the Button design tool.



Runtime Start
Click on this Button to start the runtime testing of your Visual Help project.



New Window
Feature Not Implemented.



Planning
To plan your Help topis is the first step in authoring an effective Help system, so plan well and do 
take the time to organize an outline before starting to build your project. If you are creating Help for a 
Microsoft Windows-based application, you may want to follow these guidelines.

Planning Contents Screens
The purpose of the main contents screen is to provide an overview of the contents of the Help 
system and to give clear, logical paths to information. It should work like the table of contents in a 
book.

Sub-Level Contents Screens
Sub-Level Contents screens open paths from the main contents to individual topics. Category entries
on the main contents screen jump to sub-level contents screens that either list help topics in that 
category or display other sub-level contents screens.

Guidelines for Contents Screens
Entries can be listed under several different category headings. For example, reference entries and 
procedural entries can be separated.

Entries are presented by category, as either text jumps or graphic images. List entries in logical order
(for example, by learning-path, by frequency of use, or alphabetically).

Your list should include no more than 10 entries. Avoid having more than 15 entries,    if possible. If 
your list is longer than 15 entries, try to break it up with headings or into more than one contents 
screen.

Avoid deeply nested sub-levels so the user doesn't have to jump more than two or three times to 
display a help topic.

On contents screens with entries that jump to individual Help topics, avoid long scrolling lists of 
entries.

Optimally, a Help topic is one, and at most two screens long. A Help screen is defined as 
approximately one half the width of a maximized window and 1520 lines long. 

Avoid using too many pop-up hot spots on a single screen because they can make the screen hard 
to read.



Print Setup
Open Printer Setup Dialog Box.



Remove Window
Feature Not Implemented.



Topic Name
Use this edit box to edit a new topic name, or rename a topic.



Trash Button
Click on this button to delete the selected object from the Topic.



Note Button
Click on this button to assign a note to the topic, use this to leave your self or others notes about the 
topic.



Down Button
Click on this Button to move an object down one position in a topic.



Up Button
Click on this Button to move an object up one position in a topic.



Note Icon
This note Icon will show when a note is attached to this topic. Double Click to view.



Context ID
This box will show when a Context ID is assigned to the Topic.



Save Topic
Click on this Button to save the topic to disk.



Action Button
Click on the Action Button to define an action for an object, such as a jump, macro, or a glossary 
defintion.



Image Button
Click on this Button to assign a Bitmap or Shed file to an object.



Non-scroll Button
Click on this Button to toggle Non-scroll area in the help topic.



Allign left
Click on this button to allign an object to the left side of the topic page.



Allign Right
Click on this button to allign an object to the right side of the topic page.



Keyword Button
Click on this Button to add edit or delete topic keywords.



Context Id Button
Click on this button to manualy assign a context Id to a topic.



Buttons
Clickable objects...



Compile
Using the Windows help compiler to turn Visual Helps output into a help file.



Context Id
A unique number assigned to a topic, and is used by the programmer to refference this topic in 
programming languages.



Context Sensitive
When program is smart about what the user wants help about.



GO SWREG
You can use this jump word on CompuServe to register Visual Help.



Help documents
a .hlp file that you can open using WINHELP.EXE



Hot Spots
An area in a help topic that you can click on, and will perform an action, such as jump to another topic



Keywords
Used to locate topics in a help, also they are used to build the index for the help file.



MS DOS
Microsoft Disk Operating System



Non-scroll
An area in a file that does not scroll down when the scroll bars are used to view lower parts of the topic.



Outline View
A view of the help topics hierarchy



SDK
Software Development Kit



Shed
Segmented Hyper Graphics Editor, use to edit SHG files.



SHG
Segmented Hyper Graphics, a bitmap that can contain multiple hotspots.



Sound files
Windows .wav files



Visual Help
Windows WYSIWYG help file development environment.



WINHELP.EXE
Windows help engine, it is distributed with Windows



WinWare
The company that made Visual Help a reality.






